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So, here we are – November – 

waiting to see all those turkey cut-
outs  and leaf designs all over the 
place.  Seeing the autumn “leaves” 
sometimes makes me a tad wistful to 
see the real things on the ground, 
then walk on them and hear the 
sound they make as they’re crushed.  
Of course, I quickly remember what 
follows the falling leaves; you know, 
that white stuff called snow. I think 
I’ll stick with the fake ones! 

Okay, a BIG change you need to 
be aware of in the lab. You know that 
sign over the door that says Capacity 
67? Well, we’ve been in non-
compliance with the Fire Code for 
some time, it seems. Soon, if not by 
the time you read this, it will change 
to read 37. That’s the chair at each 
computer plus seven (7) up front – 
three in front of the Macs and four in 
front of the PCs.   37 people, which 
includes teacher and any aides, seated 
or standing.  

Please remember to push in your 
chair when you vacate the lab. In the 
event of an emergency, every second 
in getting out of the room, or being 
able to drop, can prevent injury or 
death. 

Denise will be back again 
bringing her ideas for the latest 
and greatest toys for the holidays 
including : 

• ipad 
• iphone 4 
• Angry Birds Game 

 

Visit the ComputerWorks website 
at  

www.instantanswer.net  
 
and enter to win an iPad. The 
drawing will be Nov. 30th.   

 
Here’s one to shake your head 

at: Kent had laid a sheet of large 
keyboard letters/symbols on the 
counter,  which he was going to put 
on a computer keyboard.  Before he 
could do so, someone apparently 
thought he/she needed them more 
than the 600+ members of Let’s 
Compute and took the sheet.  Inci-
dentally, one of those sheets cost 
$19 plus tax. If you want more in-
formation on enlarged letters/
symbols for your keyboard, be sure 
you’re at the general meeting in 
January for the presentation.  

As to classes being offered: 
speaking as one of the instructors, 
I’m sending out a request for all of 
us. If you sign up for a class, please 
show up. If you can’t attend, please 
strike your name off the list or have 
the courtesy to call the instructor. I 
know that we call those who have 
signed up if for some reason we 
have to cancel a class. To those 
who have had the courtesy to do 
either, thank you. 

 Denise Welch will be joining 
us again to present the November 
program. She’s always informative 
and entertaining! 

Enjoy the turkey and cornbread 
dressing, sweet potatoes and green 
beans, mashed potatoes and gravy, 
and appleberry dressing. Don’t for-
get the pumpkin pie! 
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By Shirley Allan 

 
Mac SIG (Macintosh Special 

Interest Group) meets on the 3rd 
Friday at 9:00 A.M. during the 
season in the Lab.  Let's Com-
puters do not need to sign up, just 
show up and bring your questions 
and tips to share. If you would 
like to be a facilitator or get an 
email notification of the meeting, 
please contact Betsy Lewis.   

Those interested in Mac filled 
the room and were greeted by a 
picture of a Lion peeking out from 
an Apple Logo on the projection 
screen. Yours truly was this 
month’s facilitator and opened the 
meeting with the info that invita-
tions have been sent to the techni-
cal press announcing an Apple 
Special Event on October 20th. 
By the time you read this, we will 
all know what the Event will bring 
us. My guess is it is some kind of 
software as Apple has released a 
new version of its operating sys-
tem, OSX 10.6.5, to developers 
for testing, and that generally 
means they are getting ready for a 
change. If Apple announces a new 
operating system, it is wise to wait 
at least four months before install-
ing it.  

Setting custom sizes for ink jet 
printers was first on the agenda. 
The group saw how to set up size 
b y  g o ing  t o  F i le >P ag e 
Setup>Paper Size>Manage Cus-
tom size and add a paper size by 
clicking on the plus button on the 

left and naming the new paper 
size. Check your printer to see 
how to insert the new paper size 
as each printer's make and model 
is different. You can also reduce 
and enlarge your document size 
by percent in the Page Setup 
area, but it is harder to get an 
exact size (the larger the percent 
the smaller the document).  

The second demonstration 
showed how to compress files by 
selecting the document and go-
ing to File Menu>Compress 
(name of file). This creates a Zip 
file. Your Mac will tell you how 
much the file size has been re-
duced.   

The next  demonstration 
showed how to view any PDFs 
sent to you in an email with 
Quick Look to see if you want to 
keep it. The last part of this dem-
onstration took the Mac group to 
apple.com>Support>Manuals  to 
show that Apple produces a 
large number of manuals called 
User Guides in PDF.  Open a 
Manual and go to File>Save As 
to download a manual to your 
computer. Sometimes it is hard 
to find what you are looking for 
because you have to know Ap-
ple's terms. I had a heck of a 
time finding out how to create 
what I call "Swooping lines." 
You're right, that's not really a 
technical term. Apple calls them 
Connection lines. When you find 
what you want in the User 
Guide, DON'T print out the 
whole guide. Double click the 
downloaded User Guide to open 
it in Preview (far better than 
Adobe Reader which has had 
security problems). Set the Side-
bar to View>Thumbnails. Hold 
the shift key down as you select 
consecutive pages, the command 
key down as you select noncon-
secutive page, or select just one 

page from the thumbnails and 
drag your selection to the desktop. 
Print/view only the pages that you 
need and keep the manual in your 
Documents folder for later refer-
ence. If you need to fill in blanks 
on a PDF prior to printing or send-
ing it to someone, you can do this 
too with Preview. Go to 
View>Show Annotations Tool 
Bar, which will appear down at 
the bottom of a PDF.  Use the 
fourth tool from the left to drag to 
make a text box in which to type, 
and then drag the text box and 
place it in the area on the PDF that 
you want to fill in. 

Finally, the group was shown 
an easy movie greeting that you 
can make on your Mac, something 
to send to friends and relatives far 
away during the holidays. Time 
for a commercial; take my Images 
and Ink class to find out how.  

Jim Logsdon shared some Ap-
ple statistics with the group saying 
that Apple was up to $300 a 
share.  He showed off his iPad and 
asked how many others in the 
Group also had one - three others 
did.  He also commented that 
other brands of Tablets  have been 
introduced, but  that Apple would 
r e m a i n  " K i n g  o f  t h e 
Hill." Jim  asked about syncing 
his email so he doesn't have the 
duplicate mail come in to his com-
puter. The suggestions were to 
make an appointment at the Gen-
ius Bar in the new Apple store via 
their webs site (Apple Retail Store 
- El Paseo Village) to learn what 
to do or to use Apple's Discussion 
group to find an answer specific to 
iPads at Apple - Support - Discus-
sions - Syncing. Questions and 
answers already submitted there 
can be read.  To post a question 
you need an Apple ID, which you 
can obtain at myinfo.apple.com. 
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By Arlene Faber and Terry Kay 

 
Terry Kay started the meeting 

at 7:00 PM with 22 attendees. He 
encouraged each attendee to intro-
duce themselves. He also put up a 
live feed from Chile running the 
reports on the mine rescue.   

Terry described a committee 
he is on that intends to help our 
neighbors stay in their own homes 
as they age and/or begin to need a 
little help.  They have formed a 
501c3 called Desert Village Initia-
tive. More info on this will be 
forthcoming. 

A question was asked about 
“The List” and “Ruth’s List” and 
how to find them.  Terry ex-
plained The List is the nickname 
of the SCPD Group. It is an email 
communication system using Ya-
hoo Groups. Any resident can ac-
cess it at: 

ht tp: / /groups.yahoo.com/
group/SCPD 

Ruth's List is a popular com-
pendium of resident recommended 
service providers and is available 
in the Files link at the above ad-
dress. Residents must register at 
the above site to join “The List” 
and to have access to the files in-
cluding “Ruth’s List”.   

Kent McDonald provided the 
following information: 

Microsoft is offering a new 
phone, Windows phone 7.  It will 
have a touch screen, and AT&T 
will be the first company support-
ing it.  It will be available later for 
different providers with different 
features. 

Today Microsoft released 49 
patches for Windows and Office, 
and all users of the MS products 
are urged to download these 
patches. 

LA Times claims to have an 
online system for things like set-
ting up a Vacation Hold, but 
Kent reported having great diffi-
culty trying to use it.  Desert Sun 
system seems to be working. 

Google Calendar has had 
four days of outages, which 
makes some nervous about get-
ting their information when they 
need it.  Google is also canceling 
its GOOG411 directory service. 

The FBI has redesigned their 
public web site with lots of cur-
rent-event information. 

Verizon will be offering 
iPhone service and 4G service 
early next year.  A survey of pre-
sent iPhone users says that many 
will switch to Verizon when it 
becomes available.  Over 19 mil-
lion iPhone users are watching 
video on their phones for 22 
minutes every day. This amounts 
to more watched time than that 
spent by all of the people watch-
ing all of the TV networks com-
bined. 

A question was asked about 
using Facebook safely, and what 
can you put on and still be safe.  
Whatever you put In Face Book 
may be there forever. It is ad-
vised not to enter data/pictures 
that could be embarrassing. 

Terry Kay offered some new 
technology info: 

�Cisco Unified IP Phone 
7985G will have free calling.   

�Heavy use of technology 
leads to stress in college students 
but they feel connected and 
don’t want to give it up.   

�TV’s up to 80 inches are 
coming.   

�Future TV’s and computers 

will be integrated and you will be 
able to use the TV screen as a 
computer monitor. 

You can visit the Microsoft 
web site to check to see if your 
computer can support Windows 7. 

There was a question about 
finding an open source program 
for a shopping cart to use on a 
personal business web site.  It was 
suggested that you google to find 
a forum discussing that topic.   

There was discussion of cloud 
computing and backing up your 
computer.  The March General 
Meeting will have a Skype webi-
nar presentation on backing up 
your computer. 

Our next PCI SIG will be at 
7:00 PM Tuesday, Nov 9. Bring 
your PC and Internet questions for 
answers. 
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DAY DATE TIME CLASS OS BOOK TEACHER  
Mon Nov.  1 1:00 Beg Mac: Terms/Common Features (1/4) Mac 1 Shirley Allan  
  2 - 5 iPhoto Mac 1 Lyn Morse  
Tues Nov.  2 9:00 Facebook: Basic Training (1/4) PC/Mac 15 Chuck Hellman 
Wed Nov.  3 9:00 Facebook: Basic Training (2/4) PC/Mac 15 Chuck Hellman 
  1:00-3 Creating a Table of Contents PC 2 Jim Calvert 
  3:00 Excel 2007 (1/4) PC 5 John Keegan  
Thur Nov.  4 9:00 Facebook: Basic Training (3/4) PC/Mac 15 Chuck Hellman 
  1 – 2:50 Beginning Mac: Desktop (2/4) Mac 1 Shirley Allan 
  3 – 4:30 Word 2007 (1/4) PC 2 Jan Grenert  
Fri Nov.  5 9:00 Facebook: Basic Training (4/4) PC/Mac 15 Chuck Hellman 
  1 – 2:50 Adjust Photos with Elements (1/3) PC 14 Jim Calvert  
Sat Nov.  6  Open Lab 10:00 am to Noon     
Mon Nov.  8 1 – 2:50 Beginning Mac: System Preferences (3/4) Mac 1 Shirley Allan 
  4 – 5:30 Beginning PC (1/5) PC 3 Grace Hutchings 
Tues Nov.  9 1 – 2:50 Adjust Photos with Elements  (2/3) PC 14 Jim Calvert 
  4 – 5:30 Beginning PC (2/5) PC 3 Grace Hutchings 
  7:00 PC SIG   Lab  
Wed Nov.  10 1 – 2:30 PrintShop Using Images & Graphics PC 4 Arlene Faber 
  3:00 Excel 2007 (2/4) PC 5 John Keegan 
  4 – 5:30 Beginning PC (3/5) PC 3 Grace Hutchings 
Thur Nov.  11 1 – 2:50 Beginning Mac: Preventing/Solving 
       Problems (4/4) Mac 1 Shirley Allan 
  3 – 4:30 Word 2007 (2/4) PC 2 Jan Grenert 
  4:35 – 6 Beginning PC (4/5) PC 3 Grace Hutchings 
Fri Nov.  12 1 – 2:50 Adjust photos with Photoshop   
      Elements (3/3} PC 14 Jim Calvert 
  4 – 5:30 Beginning PC (5/5) PC 3 Grace Hutchings 
Sat Nov.  13  Open Lab 10:00 am to Noon     
Mon Nov.  15 8:30-10 Beginning PC (1/5) PC 3 Jim Calvert 
  1 – 2:50 TextEdit (Word Processing) Mac 1 Shirley Allan  
Tues Nov.  16 8:30-10 Beginning PC (2/5) PC 3 Jim Calvert 
  1 - 5 iMovie/iDVD Mac 1 Lyn Morse  
Wed Nov.  17 9:00 Files & Folders PC 12 Charlie Voelker 
  1:00 Intro. To Firefox PC/Mac 7 Al Sabsevitz 
  3:00 Excel 2007 (3/4) PC 5 John Keegan  
Thur Nov.  18 9:00 Board Meeting   Idyllwild Room 
  1 – 2:50 Address Book (prior to Mail) (1/4) Mac 1 Shirley Allan 
  3 – 4:30 Word 2007 (3/4) PC 2 Jan Grenert  
Fri Nov.  19 9:00 Mac SIG    Lab 
  1 – 2:50 Photoshop Elements – Making selections PC 14 Jim Calvert  
Sat Nov.  20  Open Lab 10:00 am to Noon     
Mon Nov.  22 8:30-10 Beginning PC (3/5) PC 3 Jim Calvert 
  1:00 Setting Up eMail Accounts in Mail (2/4) Mac 1 Shirley Allan  
Tues Nov.  23 8:30-10 Beginning PC (4/5) PC 3 Jim Calvert 
  2:00 General Meeting: Denise Welch   Speakers Hall  
Wed Nov.  24 8:30-10 Beginning PC (5/5) PC 3 Jim Calvert 
  3:00 Excel 2007 (4/4) PC 5 John Keegan  
Thur Nov.  25  Happy Thanksgiving (Closed until Mon.)     
Mon Nov.  29 1 – 2:50 Mail Preferences & Views (3/4) Mac 1 Shirley Allan  
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CLASS  DATE TIME  
Creating a Table of Contents 11-  3 1:00 
    
Excel 2007  

1 of  4 11-  3 3:00 
2 of 4 11-  10 3:00 
3 of 4 11-  17 3:00 
4 of 4 11-  24 3:00 

    
Facebook: PC or Mac 
Basic Training (1/4) 11-  2 9:00 
Basic Training (2/4) 11-  3 9:00 
Basic Training (3/4) 11-  4 9:00 
Basic Training (4/4) 11-  5 9:00 
    
Files & Folders 11-  17 9:00 
    
Intro. To Firefox  PC or Mac 11-  17 1:00 
 
Beginning PC Classes Session 1    
Beginning PC (1/5) 11-  8 4 :00 
Beginning PC (2/5) 11-  9 4:00 
Beginning PC (3/5) 11-  10 4 :00 
Beginning PC (4/5) 11-  11 4:35  
Beginning PC (5/5) 11-  12 4 :00  
 

CLASS  DATE TIME  
Beginning PC Classes Session 2  
Beginning PC (1/5) 11-  15 8:30 
Beginning PC (2/5) 11-  16 8:30 
Beginning PC (3/5) 11-  22 8:30 
Beginning PC (4/5) 11-  23 8:30 
Beginning PC (5/5) 11-  24 8:30 
    
    
Photoshop Elements  
Adjust Photos (1/3) 11-  5 1:00  
Adjust Photos (2/3) 11-  9 1:00 
Adjust Photos (3/3} 11-  12 1:00 
Making selections 11-  19 1:00 
    
PrintShop Using Images  11-  10 1:00 
& Graphics  
    
Word 2007 - Beginning Series 

1 of 4 11- 4 3:00 
2 of 4 11-11 3:00 
3 of 4 11-18 3:00 
4 of 4 12-2 3:00 

 
 

CLASS  DATE TIME  
Beginning Mac:  
Terms/Common Features (1/4) 11-  1 1:00 
Desktop (2/4) 11-  4 1:00 
System Preferences (3/4) 11-  8 1:00 
Preventing/Solving Problems (4/4) 11-  11 1:00 
TextEdit (Word Processing) 11-  15 1 :00 
AddyBook (prior to Mail) (1/4) 11-  18 1:00 
Setting Up eMail Acts in Mail (2/4) 11-  22 1:00 
Mail Preferences & Views (3/4) 11-  29 1:00 

CLASS  DATE TIME  
iPhoto 11-  1 2 :00 
iMovie/iDVD 11-  16 1:00 
 
Intro. To Firefox PC-Mac 11-  17 1:00 
 
Facebook: PC- Mac 
Basic Training (1/4) 11-  2 9:00 
Basic Training (2/4) 11-  3 9:00 
Basic Training (3/4) 11-  4 9:00 
Basic Training (4/4) 11-  5 9:00 
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An Advanced  
Print Shop Class 

 
By Arlene Faber 

 
My November Print Shop 

Class is intended as an advanced 
class.  This class will include 
using photos and graphics from 
sources beyond the pro-
gram.  We will explore using 
and inserting your own photos or 
images found on the inter-
net.  You will have the opportu-
nity to try text over a back-
ground photo which looks great 
on business cards, greeting cards 
and display posters.   

You should be comfortable 
working with Print Shop before 
taking this advanced class which 
will be held  

November 11 at 1:00   
  

Creating a Table  
of Contents 

 
New Class for the PC 

 
By Jim Calvert 

This summer I created a new 
class that I call “Creating a Table 
of Contents.” In the class we will 
download a number of files from 
the Internet creating a single docu-
ment. Then with less than five 
clicks of the mouse we will create 
a table of contents. I will present a 
number of other goodies in the 
class, but you have to take it to 
find out what they are. The class 
sheet will be in book 2. This will 
be hands-on. To take the class you 
should be familiar with the skills 
presented in the beginning PC se-
ries. 

This class will be held on 
November 3 at 1:00 

Know what you're revealing 
when you go online 

 
Did you ever wonder about 

those ads on a Web site that spe-
cifically mention your hometown? 
You also see ads for products you 
looked at online, but never pur-
chased. And some online ads 
seem frighteningly tailored to 
your likes. 

By simply visiting a Web site, 
you reveal more than you proba-
bly realize. They know where 
you're located and other sites 
you've visited. Sites can even 
learn intimate details about you, 
like medical conditions. 

Many sites gather information 
about your machine. They can 
tweak design elements for your 
visit. If your Internet speed is 
slow, for example, they can auto-
matically change a video's resolu-
tion. 

See for yourself what you re-
veal by simply visiting a Web site. 
Visit my Privacy Check page now 
at http://www.komando.com/
privacycheck. This page is for 
demonstration purposes only; no 
information about you or your ma-
chine is saved. 

Souce: Kim Komando's’ newsletter. 

 

Please consider your level of competency when  you sign up for any 
class that is labeled Advanced.  Students new to computers must at-
tain basic skill before taking advanced classes.   

 

Newbies: i.e….Members who are new to computers.  In November 
there are two introductory series of Beginning PC classes.  One taught 
by Jim Calvert and the same series taught by Grace Hutchings.  These 
classes will help you start to get familiar with the a PC.  Grace and Jim 
are experienced in helping students on the way to becoming familiar 
with the workings of the computer.   

We urge you Newbies to take this Beginning PC series several times, 
because each time you will learn something more.  There is a lot to 
learn, but if you learn a little one time then more the next time, you will 
become more at ease with the computer.   

 

Printing without a computer???? 
Okay, so you’ve taken a great photo 

with your cell phone, and your computer 
isn’t working; how DO you print that 
photo?  Need to print an airline ticket 
you’ve bought through an iPad app?  HP 
has a new printer (also a scanner and 
copier) that allows you to print without a 
computer.  Seem too good to be true? Go 
to www.hp.com and check out this wi-fi 
printer – it’s called Photosmart Premium 
e-All-in-One printer. 
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Day Date 10-12 12-12:50 

Mon Nov 1 P. Baigent B. Crowley 

Tue Nov 2 H. Cook K. Pearson 

Wed Nov 3 C. Voelker D. Feign 

Thu Nov 4 B. Osborn N. Alpert 

Fri Nov 5 J. Manion W. Kasner 

Sat Nov 6 L. Rowe CLOSED 

        

Mon Nov 8 P. Baigent B. Crowley 

Tue Nov 9 H. Cook K. Pearson 

Wed Nov 10 C. Voelker D. Feign 

Thu Nov 11 B. Osborn K. Gibbons 

Fri Nov 12 J. Manion W. Kasner 

Sat Nov 13 L. Rowe CLOSED 

        

Mon Nov 15 P. Baigent B. Crowley 

Tue Nov 16 K. Pearson K. Pearson 

Wed Nov 17 C. Voelker D. Feign 

Thu Nov 18 B. Osborn N. Alpert 

Fri Nov 19 J. Manion W. Kasner 

Sat Nov 20 L. Rowe CLOSED 

        

Mon Nov 22 P. Baigent B. Crowley 

Tue Nov 23 H. Cook K. Pearson 

Wed Nov 24   D. Feign 

Thu Nov 25 CLOSED CLOSED 

Fri Nov 26 CLOSED CLOSED 

Sat Nov 27 CLOSED CLOSED 

        

Mon Nov 29 P. Baigent B. Crowley 

Tue Nov 30 H. Cook K. Pearson 

 

Tip Of The Day:  
 
Emails To Look Out For 
If you get an email urging you to update your 
eBay, PayPal, or bank account information, 
chances are it's false. An easy way to tell in 
Outlook is to hover your mouse pointer over 
the hyperlink in the message. If the URL reads 
something like "www.paypal.com" in the mes-
sage, but some other address such as "www.vali
-dationcgi.org" shows up in the floating box 
next to the pointer as you hover, you can be 
pretty certain you should delete the email. 
Phishing emails attempt to get you to provide 
personal information by mimicking emails from 
legitimate companies. Most companies will 
never ask you to verify account information 
with an email, so beware of any such corre-
spondence. 

Text Talk Shortcuts 
Another Texting installment 

 
N1  Nice one 
NALOPKT Not a lot of people know that 
NATO  No action, talk only 
NAVY  Never again volunteer yourself 
NAZ  Name, address, zip 
NB4T  Not before time 
NBD  No big deal 
NBFAB Not bad for a beginner 
Ne1  Anyone 
Ne14KFC Anyone for KFC? 
NHOH  Never heard of him/her 
NIMBY Not in my back yard 
NIMJD Not in my job description 
NMP  Not my problem 
NNWW Nudge, nudge, wink, wink 
NO  Not online 
NTK  Nice to know 
 

 
What ever happened 
to  Igpay Atinlay?? 
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“Let’s Compute” Officers 
Lyn Morse, President ............................................... 760-345-4466 ........................... lynmorse@aol.com 
Shelia Harbet, VP Education .................................... 760-360-7146 ................................shelia@csun.edu 
Jan Grenert, Secretary, Newsletter Editor ................. 760-360-9085 ........................... jgrenert@dc.rr.com 
Kent McDonald, Director of Communications.......... 760-345-2931 ................ rkmcdonald@earthlink.net 
Linda Espinoza, Treasurer ........................................ 760-200-9299 ........................... puananioi@aol.com 
Barbara Kaye, Director  of Maintenance ................... 760-772-6520 ..................... barbarak1775@aol.com 
Sharon Kiel, Director of Programs ........................... 760-772-0745 ............................... srkpd@dc.rr.com 

November Teachers 
Shirley Allan .......................................... 760-345-5087 
Jim Calvert ............................................ 503-828-8815 
Arlen Faber ............................................ 760-299-3933 
Jan Grenert ............................................ 760-360-9085 
Chuck Hellman ...................................... 760-861-2175 
Grace Hutchings .................................... 760-200-0114 
John Keegan .......................................... 760-565-1646 
Lyn Morse ............................................. 760-345-4466 
Al Sabsevitz ........................................... 760-772-3025 
Charlie Voelker ...................................... 760-345-0123 
 

Bits & Bytes is distributed to 
current members of the SCPD 
“Let’s Compute” Computer 
Club, which provides this 
publication for informational 
purposes only.  The club 
neither endorses nor promotes 
any of the products or ser-
vices that have been men-
tioned or suggested herein, or 
at any meeting, and assumes 
no responsibility or liability 

Publication of the SCPD 
“Let’s Compute” Computer Club 

Address Correspondence to: 
Bits & Bytes 

38180 Del Webb Blvd. 
Palm Desert, CA  92211 

Volunteer Coordinators 
Call to volunteer: 

35 MM Scanner Coordinator  George Hans ............ 345-3875 
General Meeting Volunteers June Cross ................ 345-7876 
Supplies  Sharon Kiel .............. 772-0745 
 
Monitor Coordinator Moe Sullivan ............ 772-4416 
 Email:modewans@hotmail.com 
 

November  Lab Monitors 
Norm Alpert David Feign Bob Osborn 
Peter Baigent Kevin Gibbons Kurt Pearson 
Herb Cook Walt Kasner Leonette Rowe 
Bill Crowley John Manion Charley Voelker 
 

35 MM Scanner Monitors 
George Hans   Leonette Rowe   

Committee Chairs 
Betsy Lewis .................... Finance Review Committee 
June Cross .......................................... Computer Sale 
Nominating Committee ..................................... Open 

 

PC SIG .............................. Nov.  9.................... 7;00 PM 
BOARD MEETING ............ Nov. 18................... 9:00 AM 
MAC SIG ........................... Nov. 19................... 9:00 AM 
GENERAL MEETING ....... Nov. 23................... 2:00 PM  


